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Prerequisites and Dependencies 
The following assumptions have been made in this document. 

Number Description 
1.  Availability of SAP HANA Cloud Platform (HCP) account for production or trial account. 

2.  Understanding of Fiori paradigm and UI5 application development for maintaining the application. 

3.  SAP HANA Cloud Connector (HCC) configuration is complete in the landscape where backend services 
reside. Further, the HCP account must be set up in the HCC with relevant resource configurations. 

4.  Understanding of SQL Server Management Studio and IIS basics. 

5.  The operating system of the DSP web server on which the server side components of the Fiori solution are to 
be deployed must be Windows 2012 or 2012 R2. 2008/R2 is not supported. 
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Introduction 

Purpose and Scope 
The purpose of this document is to provide a step by step guide for deploying Fiori Launchpad and tiles on an SAP 
HANA Cloud Platform (HCP) account. The document provides instructions to export destinations, sites (tiles), and 
applications (UI5) from a source HCP account to a destination account.  

The import process can be performed using the deployment package provided. 

The installation includes all the required artifacts that have been exported with this document. Hence, all export steps in 
the document are not required. Import steps should be followed using relevant artifacts. 

Audience 
This document is for the consulting team and technical administration teams that need to deploy the Fiori Migration 
Metrics tiles that are an optional component of the SAP Advanced Data Migration Solution by Syniti. 
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Deploy OData Services on Premises 
The following sections detail the setup and deployment of the OData database and the corresponding OData services that 
support the Fiori deployment and expose the metrics captured in the Syniti Data Stewardship Platform (DSP), Advanced 
Data Migration (ADM), Information Steward Accelerator (ISA), or base DSP deployment). 

Before deploying, ensure that you have an administrator OS account and the main cransoft / DSP user account for the 
SQL Server environment of the DSP. 

To deploy the OData services:  

1. Create the OData Database 

2. Run OData Database Scripts 

3. Install Microsoft WebDeploy 3.5 

4. Edit the FioriWCFDataService.SetParameter.xml File 

5. Run FioriWCFDataService.deploy.cmd 

6. Check Deployment of OData Services 

Create the OData Database  
To create the OData database in SQL Server Management Studio: 

1. Right click the Databases folder in the DSP SQL Server instance that you are going to deploy the OData Services 
against and select New Database. 

2. Enter OData in the Database Name field. 
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3. Set the owner as the CranSoft or DSP user that has access to all of the DSP application databases. Note the 

username and password as it is required to connect to the SAP HANA Cloud Connector (HCC) later in these 
steps. 

NOTE: The database will contain views only. It is not necessary to change the default values in the Initial Size (MB) 
column.  

Run OData Database Scripts 
To create the required views to support the OData services: 

1. Copy the scripts from the <Deployment Package>/SQL Scripts/OData-Solex.sql into a New Query window in 
SQL Server Management Studio. 
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2. Execute the script. 

NOTE: If this is the initial script execution, it is expected that errors will be returned as the drop commands will fail. 
After the initial run, the errors do not display. 

Install Microsoft WebDeploy 3.5 
Use the Microsoft WebDeploy application to deploy the code required to expose the OData services. 

1. Run the WebDeploy_amd64_en-US.msi package delivered in the FioriODataDeploy subfolder of the 
deployment package as Administrator. 

 
2. Choose the Typical deployment option. 
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Edit the FioriWCFDataService.SetParameter.xml File 

 
1. Unzip the compressed file FioriWCFDataServicesDeploy.zip. 
2. Edit the FioriWCFDataService.SetParameter.xml file.  Change the following parameters to your environment setup: 

• YOURSERVERIP = IP address of your DSP database server, e.g., 12.34.56.789 

• YOURSQLUSER = SQL user with access to the OData database, e.g., cransoft or DSP 

• YOURSQLPASSWORD = SQL password for the above user 
3. Save the file ensuring it is still in the same directory as the other files referenced in the previous screenshot / step 

(FioriODataDeploy subfolder). Then, run the command file FioriWCFDataService.deploy.cmd using the following 
steps. 

 
4. Open a command prompt on the DSP server using the Run as Administrator option. 
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5.  Change directory to the Deployment Package directory containing the file FioriWCFDataService.deploy.cmd 
(unzipped in previous steps). 

6. Enter the command FioriWCFDataService.deploy.cmd /T to test the deployment of the OData Service.  If no errors 
are returned, execute the same command replacing the /T parameter with /Y. 

Contact SAP Support at https://launchpad.support.sap.com using component XX-PART-BOA if any errors display during 
the installation. 

Potential Errors 
1. If the error message "ERROR_APPPOOL_VERSION_MISMATCH" displays, ensure that the DefaultAppPool 

.NetFrameworkVersion is set to v4.0 not v2.0.  Verify the setting in the IIS Manager by selecting Application Pools 
under the Server. 

2. If errors display indicating that the server cannot be reached, the connection parameters may be incorrect in the 
FioriWCFDataService.SetParameter.xml. If the database application server and DSP application server are on 
separate servers, ensure that the IP address and user / password provide the connection information to the database 
application server and not the DSP application server. 

3. If the following error message displays "Error:  This access control list is not in canonical form and therefore cannot 
be modified. Error count: 1.", follow the steps below as the User Access Control (UAC) on the Windows server nust 
be changed to allow for the installation to proceed.  
 
On the DSP Web Server: 

a. Navigate to C:\inetpub\wwwroot\odata. 

b. Right-click the odata folder and select Properties. 

c. Select the Security tab. 

d. Select Administrators then click Edit. 

e. Click Reorder on the Windows Security window that displays. 

f. Click Apply. 

g. Click Ok to close windows. 

Check Deployment of OData Services 
1. Open Internet Information Services (IIS) Manager. 

2. Check that the odata application has been deployed into the Default Web Site folder. 
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NOTE: To deploy the application into a different web site, modify the XML configuration file used for the deployment to 

use that web site, and confirm that the odata application has been deployed into that web site.  
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4. Open a web browser and enter the server address and port that your application is running on with the suffix /odata/OData.svc/. 
A page similar to the one above displays, showing the OData services available in the application. These OData Services are going 
to be consumed by SAP Fiori and the HCC. 

Troubleshoot Error Connecting to OData Services 
If the following error displays on entering the URL defined in step 3 above, then the issue may be related to the order in which 
components on the Windows operating system have been installed. 
 
Could not load type 'System.ServiceModel.Activation.HttpHandler' from assembly 'System.ServiceModel, Version=3.0.0.0, 
Culture=neutral, PublicKeyToken=b77a5c561934e089' 

 
To resolve the issue: 
1. Run C:\Windows\Microsoft.NET\Framework\v4.0.30319\aspnet_regiis.exe –iru from a command prompt 

running under Administrator privileges. 
2. Repeat the test of the OData.svc connection. If the same error displays, continue with step 3. 
3. From the Start menu, choose Programs > Administrative Tools > Server Manager. 
4. In Server Manager, under Features Summary, click Add Features. 
5. In the Add Features dialog, under.NET Framework 3.0 Features, select the .NET Framework 3.0.  
6. Under WCF Activation, select HTTP Activation and click Next to install. 
7. In Server Manager, under Roles Summary, verify that Web Server (IIS) appears in the list of available roles. If it does 

not, click Add Roles to install Internet Information Services. 
8. In Server Manager, under Roles Summary, click Web Server (IIS). 
9. In the Web Server (IIS) management window, click Add Role Services. 
10. In the Add Role Services dialog, expand Web Server, then Application Development. 
11.  Select ASP.NET and click Next to install. 

If any other issues are encountered, contact SAP Support at https://launchpad.support.sap.com using component XX-
PART-BOA. 

SAP HANA Cloud Connector (HCC) Installation 
SAP HANA Cloud Connector (HCC) serves as the link between on-demand applications in SAP HANA Cloud Platform 
(HCP) and existing on-premises systems. 

HCC runs as an on-premise agent in a secured network and acts as a reverse invoke proxy between the on-premises 
network and SAP HANA Cloud Platform (HCP). Due to its reverse invoke support, it is not necessary to configure the 
on-premises firewall to allow external access from the cloud to internal systems. 

On Microsoft Windows, two installation modes are available: Developer version and Productive version.  
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• Windows: https://help.hana.ondemand.com/help/frameset.htm?204aaad4270245f3baa0c57c8ab1dd60.html 

Choose one of the procedures listed below to install HCC 2.x on the DSP application server depending on the operating 
system. 

Developer Version 

Install the HCC 2.x Developer version by extracting a compressed archive into an empty directory. It does not require 
administrator or root privileges for the installation.  

Restrictions using this method: 

• It cannot be run in the background as a Windows Service. 

• It does not support an automatic upgrade procedure. To update a Developer installation, delete the current 
installation, extract the new version, and then configure it again.  

Productive Version 

To install the HCC 2.x Production version requires administrator permissions for the installation. The installation can be 
set up to run as a Windows Service. It can also be easily upgraded, retaining all the configuration and customizing. 

Prerequisites 
• One of the following 64-bit operating systems is required:  

o Windows Server 2012 

o Windows Server 2012 R2 

• Download either the ZIP archive for the Developer version on Windows or the MSI installer for the Productive 
version from the SAP Development Tools for Eclipse page (https://tools.hana.ondemand.com/). 

• Install Microsoft Visual Studio C++ 2010 runtime libraries. For more information, see Microsoft Visual Studio 
C++ 2010 Redistributable Package (x64). 

• Install Java 7. To use SAP JVM, download it from the SAP Development Tools for Eclipse page (Cloud page) 
(https://tools.hana.ondemand.com/). 

• Set the environment variable <JAVA_HOME> to the Java installation directory, so that the bin subfolder can be 
found. Alternatively, when using the ZIP file, you can add the relevant bin directory to the <PATH> variable. 

Steps to Install Productive Version 
1. Download HCC from https://tools.hana.ondemand.com/#cloud. 

2. Double-click the <sapcc-<version>-windows-x64.msi> installer. 

3. The installer informs you that you are now guided through the installation process, click Next. 

https://help.hana.ondemand.com/help/frameset.htm?204aaad4270245f3baa0c57c8ab1dd60.html
https://tools.hana.ondemand.com/#cloud
http://help.sap.com/disclaimer?site=http://www.microsoft.com/en-us/download/confirmation.aspx?id=14632
http://help.sap.com/disclaimer?site=http://www.microsoft.com/en-us/download/confirmation.aspx?id=14632
https://tools.hana.ondemand.com/#cloud
https://tools.hana.ondemand.com/#cloud
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4. The installer reminds you that you need to have Java 6 or a later version installed. If you have met this 
requirement, click Next. 

5. Select the port on which the administration UI is reachable. Either leave the default 8443 or choose a different 
port. Then click Next. 

6. Select the JDK to be used for running the HCC. The installer displays a list of all JDKs of version 7 installed on 
the machine. If the needed JDK is not listed in the drop-down box (for example, if it's an SAP JVM that is not 
registered in the Windows Registry upon installation), browse to its installation directory and select it. It is 
recommended to use an up-to-date Java 7 installation to run the HCC.  

7. Click Next.  

8. If the HCC should not start immediately after finishing the setup, remove the check from the checkbox. 
Note: The assumption is that the service should be started immediately.  

9. Click Next. 

10. Click Next again to begin the installation. 

11. Click Close when the installation is complete. 

12. In a browser, enter: https://<hostname>:8443, where <hostname> is the host name of the machine on which the 
HCC is installed. 

NOTE: If you access the HCC locally from the same machine, enter localhost. 

13. For initial configuration (initial password, proxy settings etc.) refer to 
https://help.hana.ondemand.com/help/frameset.htm?db9170a7d97610148537d5a84bf79ba2.html. 

HCC as a Windows Service 

In the Productive version, HCC is started as a Windows Service. It must automatically start after a reboot of your system, 
so installation requires administration permissions. After installation, the service must be administrated under Control 
Panel > Administrative Tools > Services. The service name is SAP HANA Cloud Connector 2.0. 

For further information, refer to the Windows installation link: 

https://help.hana.ondemand.com/help/frameset.htm?204aaad4270245f3baa0c57c8ab1dd60.html 

SAP HANA Cloud Connector (HCC) Configuration 
To configure the HCC, perform the following tasks, which are covered in the steps below: 

1. Add an Account 

2. Map Virtual to Internal System 

3. Add Resources 

4. Verify the Account 

https://help.hana.ondemand.com/help/frameset.htm?db9170a7d97610148537d5a84bf79ba2.html
https://help.hana.ondemand.com/help/frameset.htm?204aaad4270245f3baa0c57c8ab1dd60.html
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Add an Account 

1. Log on to HCC as the Administrator. 

 
2. Click the Account Dashboard. 

3. Click the Add button. 

 
4. Either  

Enter hanatrial.ondemand.com in the Landscape Host field if this is a trail account. 
NOTE: Below that Account Name is <sUserId>+trial  
OR 
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Enter hana.ondemand.com in the Landscape Host field if this a productive HCP account and enter the account 
details.  

 

 
5. Click OK. 

The Account Dashboard displays. The new account displays a yellow icon in the status column, indicating that the 
account doesn’t have any active resources. With the new account selected in the drop down on the left, select the Access 
Control link. 

Map Virtual to Internal System 

1. Click the Add button under the section Mapping Virtual To internal System. 

2. Select Non-SAP System in the Back-end Type field. 

3. Click Next. 

4. Select HTTP in the Protocol field. 

5. Click Next. 

6. Enter the exact Host name to the back end, as it would look in your running application, in the Internal Host 
field.  

7. Enter the port on which your application resides in the Internal Port field. 

8. Click Next. 

9. Enter the Virtual Host and Virtual Port details that you want to use as the alias on the HCP account e.g. 
DSPServerEurope / 843. 

10. Click Next. 
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11. Enter a description into the Description field if required. 

12. Click Next. 

13. Click the Check availability of internal host check box to enable it to verify that the connection can be 
established.  

14. Click Finish. 

 

 
If the connection is successful, the new virtual connection displays in the Mapping Virtual To internal System table. 

 
 

Add Resources  

1. Select the newly created virtual Host.  
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2. In the Resources Accessible table, click the Add button.  

 
3. Ensure the Enabled check box is selected.  

4. Enter the URL to your application in the URL Path field. 

NOTE: Use the base URL to the odata service:  odata/OData.svc. 

5. Select the Path and all sub-paths option. 

 
6. Click Save. 

7. Click the Save button.  

After this step is complete, HCC is configured to be used from within HCP Destinations. 
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Verify the Account 

1. After allocating resources, click Account Dashboard. 

 
2. Find the account just added in the ‘Account Dashboard’ table. 

The Status column should contain a green square icon as highlighted in the image. 
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Access the SAP HANA Cloud Platform (HCP) Account 
1. Log in to the HCP account at http://account.hana.ondemand.com. 

 
2. Click Log On.  

http://account.hana.ondemand.com/
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The dashboard of your HCP account displays. 

 
Use the dashboard to access: 

• WebIDE – Integrated development environment for developing UI5 applications 

• Destinations – For configuring destinations to access backend 

• Services – For accessing SAP HANA Cloud Portal for configuring Launchpad and Tiles 
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Export and Import Destination Configurations 
Destinations are used to access backend functionality available on the internet or on an on-premise environment. This 
section describes steps to export and import destination configurations from a source HCP account to a destination HCP 
account. 

Access Destinations 
In the HCP dashboard, click Destinations. 

 
NOTE: If the account is used for the first time, there might be no existing destinations and so the table might be blank 

which is expected.  

Export Destination Configurations 
NOTE: This step could be skipped if deployment is not to be moved from a source account to destination account and 

the exported entities are already available. In the present context, exported destination files are present in zip 
(installation media) in ‘Destination Export’ folder. 

In the source HCP account, click the down arrow to export a destination. 
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Import Destination Configurations 
1. In destination HCP account, click Import Destination. 

  
2. Select the destination file in the file selector. 
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NOTE: If the deployment is not to be moved from a source account to destination account, then access exported 
destination files from folder “Destination Export” in the deployment zip (installation media) for importing 
destinations. 

After selecting destination, the screen populated with destination details displays. 

3. Click Save. 

 
NOTE: Changes to the imported destinations are optional, but would be required if there is a change in the backend 

services that are accessed through the destinations (e.g., if the authentication mechanism changes). 

Deploy Imported WebIDE Projects to SAP HANA Cloud Platform (HCP) 
This section contains the following tasks:  

1. Access WebIDE 

2. Export WebIDE Projects 

3. Import WebIDE Projects 

4. Update the Account Field in Imported Projects 

5. Deploy to HCP 
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Access WebIDE 
1. Select Subscriptions from the left menu in the HCP dashboard. 

 
2. From the Subscribed HTML5 Applications table, click the webide link in the Application column. 

 
The details screen displays. 

3. Click the Application URL. 
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The WebIDE window displays in a separate tab. 

NOTE: If the WebIDE opens to a screen like the one below, click the </> button to open the editor. 

 

Export WebIDE Projects 
NOTE: This step could be skipped if the deployment is not to be moved from a source account to a destination account 

and exported entities are already available. In the present context, exported projects are present in zip 
(installation media) in ‘WebIDE UI5 Application Export’ folder. 

1. In the source HCP account, right-click the relevant applications and click Export. 
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The application is exported to the default download location. 

2. Repeat this step for all the relevant UI5 applications. 

 

Import WebIDE Projects 
1. In the destination HCP account, click File > Import > From File System.  
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NOTE: If the deployment is not to be moved from a source account to a destination account, then access exported 
project files from folder “WebIDE UI5 Application Export” in the deployment zip(installation media) for 
importing destinations. 

2. Click the Browse button and select the UI5 application zip. 

3. Verify the auto-populated details and click Ok. 

 
4. Repeat the above steps for all the relevant UI5 applications.  

Applications to import: 

• Compose_RequestsActive 
• Compose_RequestsArchived 
• Compose_RequestsInactive 
• ISA_ErrorCountByReport 
• Migrate_ConstructionStatus_Detail 
• Migrate_FieldMappingStatus_Detail 
• Migrate_TargetDesignStatus 
• Migrate_ValueMappingStatus_Detail 
• Track_OverdueTasks 
• Track_TaskStatus_Detail 
• User_MyComposeRequests 
• User_MyISAErrorCount 
• User_MyReportsActionable 
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• User_MyReportsBusiness_Detail 
• User_MyWorkList 

Update the Account Field in Imported Projects 
1. Expand the node/folder of the imported project.  

 
2. Access .project.json file in the root folder of each imported application. 

3. Search for ‘hcpdeploy’. 

4. For hcpdeploy object in json, change the value for account field to the current/destination account. 

 

User Configuration 
The following applications and tiles related to the following applications are run by user-specific data, i.e., the data is 
filtered based on the current user of the application.  

• User_MyComposeRequests 
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• User_MyISAErrorCount 

• User_MyReportsActionable 

• User_MyReportsBusiness_Detail 

• User_MyWorkList 

At runtime it is possible to access the SAP user ID of the logged in user. However, the data in the backend is stored 
according to Syniti user IDs. For this purpose, the above projects contain a user mapping object to map an SAP user to a 
corresponding Syniti user.  

To modify or add to the user mappings: 

1. Access the user mapping file: user-mapping.json. 

2. Expand project folder in WebIDE. 

 
3. Under root folder, navigate to the webapp > config folder. 
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4. Open user-mapping.json in the editor. 

 
This file contains all the user mappings. 

Deploy to HCP 
1. Right-click the project. 

2. Select Deploy > Deploy to SAP HANA Cloud Platform. 
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3. Click the Deploy a new application check box to enable it if this is the first deployment or select Update an existing 

application if you are deploying for a subsequent time. 
4. Click Deploy. 
5. Click Close when the success message displays. 

 
6. Repeat for each Application. 
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Enable the SAP HANA Cloud Portal and Deploy the Site 

Access SAP HANA Cloud Portal 
1. Select Services from the left menu in the HCP dashboard. 

2. Click SAP HANA Cloud Portal. 

 
NOTE: Refer to Enable SAP HANA Cloud Portal section below if this option displays with a grey button.  

3. Click Go to Service. 
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4. Select Site Directory. 

 

Enable SAP HANA Cloud Portal 
If needed, enable the SAP HANA Cloud Portal.  

1. Select Services from the left menu in the HCP dashboard. 

If the SAP HANA Cloud Portal is not enabled the button for that option displays in grey.  

 
2. Click SAP HANA Cloud Portal. 

The Overview page for SAP HANA Cloud Portal displays.  
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3. Click Enable to enable the service. 

 

Export Site 
NOTE: This step could be skipped if the deployment is not to be moved from a source account to a destination account 

and the exported entities are already available. In the present context, the exported site is present in zip 
(installation media) in ‘Hana Cloud Portal Site Export’ folder. 

Perform these actions in the source HCP account. 

1. Hover over the bottom of the tile (where the name and published date displays) for the site that is to be exported. 

 
2. Click the down arrow next to Edit. 
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3. Select Export. 

The zip file is downloaded to the default download folder for your browser. 

Import Site 
1. In the destination HCP account, click the Import Site button. 

2. In the file selector, select the site export zip <installation media>\Hana Cloud Portal Site 
Export\SAP_exported_site.zip. 
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NOTE: If the deployment is not to be moved from a source account to destination account, then access the exported site 

from the folder “Hana Cloud Portal Site Export” in the deployment zip(installation media) for importing site. 

Access the Fiori Portal 
1. Click the URL on site’s tile to access the Fiori Launchpad. 

2. In the new imported tile, hover on the bottom of the tile (where the name and published date is displayed). 

 
The URL for Fiori Launchpad displays.  
3. Click the URL.  
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The Fiori Launchpad displays in a new window, with the relevant tiles to all the Fiori applications. 
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